BlackBerry AtHoc
ATI Giant Voice System Installation and Configuration Guide
Getting started

The BlackBerry AtHoc management system uses the IIM add-on module interface with Giant Voice (GV) outdoor warning devices to enable wide-area Mass Notification System (MNS) broadcasts. Giant Voice features can broadcast critical information using voice messages, wave files, musical tones, or text-to-speech (TTS) conversion. The ATI GV supports outdoor Public Address (PA) systems that have large amplified speakers. Typically, speakers are set on poles and controlled by their connected Remote Terminal/Transceiver Units (RTUs). The speakers on the poles are configured in an array that covers a specified area with enough acoustic sound to override the ambient noise with emergency notification audio broadcasts. This guide describes the brand of GV system that is built and installed by Acoustic Technologies, Incorporated (ATI).

After the BlackBerry AtHoc management system is integrated with the ATI Giant Voice System, operators can disseminate emergency alerts to the siren system from the BlackBerry AtHoc management console. Alert messages can be delivered using Key functions programmed in the ATI hardware or software, text-to-speech or pre-recorded audio files to dynamically selected targets. Targeting choices are All Poles simultaneously, individual Zones of poles, and Poles.

Note: To see which BlackBerry AtHoc releases support this integration, see the BlackBerry AtHoc Supported Integrations document.

Product requirements

The following section describes the IIM and BlackBerry AtHoc console hardware and software requirements to install and configure the ATI Giant Voice system.

Hardware requirements

- ATI REACT4000 Central Controller Unit (CCU) with “AtHoc ready” components
- ATI MassAlert™ Software with “AtHoc” drivers

Software requirements

- BlackBerry AtHoc release 6.1.8.84 or later release
- IP Integration Module capnode_obf.jar 8/19/2009 or later

Specific usage data collection

Configuration of a ATI integration requires attention to detail as there are many components to be configured and data to be collected. Connection with the ATI REACT4000 encode is made through an RS-232 serial cable, analog audio connection.

In addition to the basic Public Address functions that allow the play of pre-recorded audio or text-to-speech audio over the ATI Giant Voice system, the BlackBerry AtHoc ATI device allows mapping of pre-recorded audio messages and tones stored at the poles themselves. These Key functions allow for the highest audio clarity available through the system and should be configured as a priority.

Public Address and key activations allow dynamic targeting of poles, zones, or all poles simultaneously. In most cases, emergency broadcasts target all poles simultaneously. If more detailed targeting is desired, a list of poles, location names, pole/zone grouping, and zone location names should be collected.

Special REACT4000 and MassAlert™ software configuration and programming is required for BlackBerry AtHoc integration and should only be configured by a factory authorized service representative.
The ATI Giant Voice poles are programmed with RTU functions. A table of these functions needs to be collected to record which RTU function number contains the Public Address function. This information can be found by observing the Activation and Areas table within the MassAlert™ software. In most cases it can obtain a matrix of Activation, Areas, Poles, and Groups directly from ATI.

In most cases when a site currently has an REACT4000 encoder, the encoder needs to be replaced with a new REACT4000 encoder with the required hardware and firmware versions to facilitate continuation of legacy functionality while adding the BlackBerry AtHoc integrated functionality. Primarily this is because the COTS REACT4000 encoder only has one external RS-232 serial port, such that any single REACT4000 unit can only be connected to ATI MassAlert™ PC.

The AtHoc ready REACT4000 Central Control Unit (CCU) encoder has two serial ports and both the ATI MassAlert™ PC and the BlackBerry AtHoc IIM can be connected concurrently and also has BlackBerry AtHoc-specific internal configuration and programming. It is not possible to tell from a simple visual inspection if a REACT4000 CCU is a BlackBerry AtHoc integration. Contact ATI or a factory authorized service representative for any complaints and consultations.

If the site plays audio files not currently stored at the poles or in the BlackBerry AtHoc audio library, additional .wav files can be provided by the site to add them to the BlackBerry AtHoc library. These .wav files should be converted to mono, compressed down to 8 or 16-bit sampling, and have all frequencies below 400 Hz removed before uploading.

If the GV system uses radio frequency (RF) communications between the CCU and RTUs, check the associated radio Push-To-Talk Time-Out-Timer setting. This setting must be set to 5 minutes or “infinite” to ensure that audio transmissions do not get cut off. Check with the site’s GV System Maintenance or RF System Maintenance POC to ensure that this setting is correct.

When an alert is received by the IIM:

- The IIM sends an actuation serial command to the REACT4000 and pauses.
- The REACT4000 encoder transmits the actuation data with the selected target to the poles.
- If the intended content was PA, the IIM plays the selected audio content.
- The IIM sends a cancel all serial command to the REACT4000 and pauses.
- The REACT4000 transmits the cancel all data to the poles.
- If additional targets are specified, the cycle repeats the sequence with the next specified target and content.
Configure the ATI device in BlackBerry AtHoc

Configure the ATI device in the Settings section of the BlackBerry AtHoc management system to enable the BlackBerry AtHoc alerts system to publish alerts through ATI.

Configure the ATI device on the BlackBerry AtHoc application server

Log in to the BlackBerry AtHoc management console and check the Delivery Gateways section to verify that the ATI and XML Feed device gateways have been installed. If they are installed, skip this section.

1. Log in to the BlackBerry AtHoc application server as an administrator.
2. Navigate to the following folder: <IWSAlerts Install Path>\ServerObjects\Tools and run the AtHoc.Applications.Tools.InstallPackage.exe file.
3. On the Configure Device Support screen, select ATI Giant Voice and XML Feed.
4. Click Enable to install the devices.
5. On the Installation Complete window, click OK.
6. Click Close.

Configure the ATI devices

To configure the ATI general devices, you must have a base concept of the functions and areas programming of the REACT4000 that you are integrating with IIM. The RTU functions and areas listing table can be obtained by manually reading out the list from the ATI MassAlert™ software on the PC connected to the REACT4000, the REACT4000 hardware menus, or obtaining the list from the ATI engineer who installed the system originally. This is usually the best way to obtain the list before being in front of the specific REACT4000. The following is a sample functions list obtained from ATI.

<table>
<thead>
<tr>
<th>Activation</th>
<th>Area #’s</th>
<th>Exercise</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cancel</td>
<td>—</td>
</tr>
<tr>
<td>2</td>
<td>Weekly Siren Test</td>
<td>—</td>
</tr>
<tr>
<td>3</td>
<td>Attack</td>
<td>—</td>
</tr>
<tr>
<td>4</td>
<td>National Anthem</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>Tornado</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>Heat Stress</td>
<td>1,2,3,4</td>
</tr>
<tr>
<td>7</td>
<td>Public Address</td>
<td>—</td>
</tr>
</tbody>
</table>

Each function has a specified function name, a numbered "Key", and a designator to identify if the function is sent out as an "Emergency" or an "Exercise" function. For example: Key 1 is programmed for the “Cancel” function, as an Emergency (Non-Exercise) function. Key 2 is programmed for the “Weekly Siren Test”, as an Emergency function. Since the majority of installations use their GV systems mostly during their base-wide exercises, ATI codes their functions as either an “Emergency” function or an “Exercise” function. For the purposes of our programming of the BlackBerry AtHoc system, we consider every message that is not explicitly labeled
or called as an “Exercise” message, is initiated, as a default mode, as an “Emergency” message. In this example all messages are considered as “Emergency” messages. All of these keys are easy to map, except for Key 6 the “Heat Stress” function. In this type of configuration there are multiple functions and derivations (“areas” or “sub-areas”) of that function, programmed under that one key.

In the standard “non-area” key, there is only one function that is associated with that key. For example, Key 1, if initiated, only queues the “Cancel” function for the targeted list of poles, zones, or sites (RTUs). Similarly, when initiated, Key 2 only queues the “Weekly Siren Test” function for the targeted list of poles, zones, or sites.

However, whenever Key 6 is initiated, it does not immediately queue to send out the “Heat Stress” function to the targeted sites. When Key 6 is initiated it opens up another menu, that has a list four additional derivations of the Heat Stress function such as “Heat Stress Condition 1”, “Heat Stress Condition 2”, “Heat Stress Condition 3”, and “Heat Stress Condition 4”. These four sub functions are called “areas” by ATI. The following is a sample of key configuration, if we put those key functions in a ladder-logic type:

<table>
<thead>
<tr>
<th>Key #1: Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel: initiate</td>
</tr>
<tr>
<td>Key #2: Weekly Siren Test</td>
</tr>
<tr>
<td>Weekly Siren Test: initiate</td>
</tr>
<tr>
<td>Key #3: Attack</td>
</tr>
<tr>
<td>Attack: initiate</td>
</tr>
<tr>
<td>Key #4: National Anthem</td>
</tr>
<tr>
<td>National Anthem: initiate</td>
</tr>
<tr>
<td>Key #5: Tornado</td>
</tr>
<tr>
<td>Tornado: initiate</td>
</tr>
<tr>
<td>Key #6: Heat Stress Condition</td>
</tr>
<tr>
<td>Heat Stress Condition 1</td>
</tr>
<tr>
<td>Heat Stress Condition 1: initiate</td>
</tr>
<tr>
<td>Heat Stress Condition 2</td>
</tr>
<tr>
<td>Heat Stress Condition 2: initiate</td>
</tr>
<tr>
<td>Heat Stress Condition 3</td>
</tr>
<tr>
<td>Heat Stress Condition 3: initiate</td>
</tr>
<tr>
<td>Heat Stress Condition 4</td>
</tr>
<tr>
<td>Heat Stress Condition 4: initiate</td>
</tr>
<tr>
<td>Key #7: Public Address</td>
</tr>
<tr>
<td>Public Address: initiate</td>
</tr>
</tbody>
</table>

Configure the ATI and XML Feed delivery gateways

Once you understand the RTU function programming of the system, the next step is to configure the ATI delivery gateway information in the BlackBerry AtHoc management system.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. In the navigation bar, click ATI.
3. In the Devices section, click ATI Giant Voice.
4. On the ATI Giant Voice page, click Copy default settings.
5. Click Save.
6. In the navigation bar, click 

7. In the Devices section, click Xml Feed.
8. On the Xml Feed page, click Copy default settings.
9. In the Feed Source section, select Delivery Gateway ID.
10. Click Save.

Enable the ATI Giant Voice device

1. In the navigation bar, click 🔄.
2. In the Devices section, click Devices.
4. Click ATI Giant Voice.
5. On the ATI Giant Voice page, click Edit.
6. In the Delivery Gateways section, click Add a Delivery Gateway > ATI Giant Voice.
7. In the ATI Giant Voice row, click

8. On the Configure Gateway window, check for XML code in the Configuration XML field. Even if the configuration value appears in the Configuration XML field, copy and paste the following code into the field:

```xml
<Configuration>
  <CapParams>
    <GVSystemType>ATI</GVSystemType>
    <AllMode>0</AllMode>
    <ZoneMode>2</ZoneMode>
    <PoleMode>1</PoleMode>
    <KeyMode>4</KeyMode>
    <DynamicMode>4</DynamicMode>
  </CapParams>
</Configuration>
```
<UnusedMode>0</UnusedMode>
<DefaultAllCall>0</DefaultAllCall>
<DefaultKeyActivationCode>0</DefaultKeyActivationCode>
<NoPARequired>0</NoPARequired>
<PARequired>1</PARequired>
<IsCancelable>false</IsCancelable>
<ContentSource>GiantVoice</ContentSource>

<DefaultKey>
<key id="7|HasPA|Emergency|HasStrobe|Null"
messageIdRef="MSG-TARGETING-REQUIRED"
targetingRule="TargetingRequired">
<name>PA Mode</name>
<description>Activate PA Mode for Text-to-Speech(TTS)</description>
</key>
</DefaultKey>

<PAMode>
<Mode>
<Name>NoPA</Name>
<Value>0</Value>
</Mode>
<Mode>
<Name>HasPA</Name>
<Value>1</Value>
</Mode>
</PAMode>

<MessageTypeMode>
<Mode>
<Name>Emergency</Name>
<Value>0</Value>
</Mode>
<Mode>
<Name>Exercise</Name>
<Value>1</Value>
</Mode>
</MessageTypeMode>

<StrobeMode>
<Mode>
<Name>HasStrobe</Name>
<Value>0</Value>
</Mode>
<Mode>
<Name>NoStrobe</Name>
<Value>1</Value>
</Mode>
</StrobeMode>

<SubCommandMode>
<Mode>
<Name>Null</Name>
<Value>0</Value>
</Mode>
<Mode>
<Name>HeatCondition1</Name>
<Value>1</Value>
</Mode>
<Mode>
<Name>HeatCondition2</Name>
<Value>2</Value>
</Mode>
<Mode>
<Name>HeatCondition3</Name>
<Value>3</Value>
</Mode>
</SubCommandMode>
For the data entered in the "Default Key" section of the XML, the device ID is set to 7. The default function used for IIM is PA function. When the IIM initiates a message it queues the message to be sent as a pre-recorded WAV file or TTS WAV file by default. The other key functions are sent as non-default functions, through the KEY device. In the functions list above, the “PA” function is number 7, thus the default function of the IIM is set to “7”.

The “Sub-Commands” section is where you map the ATI areas of the system. The Sub-Commands or areas programmed in the RTUs is listed in this section of the device XML file. The actual functions of those areas are programmed in the key device endpoint XML file.

Enable the Xml Feed device

1. In the navigation bar, click.
2. In the Devices section, click Devices.
3. In the Devices page, click the Mass Devices tab.
4. Click Xml Feed.
5. On the Xml Feed page, click Edit.
6. In the Delivery Gateway section, click Add a Delivery Gateway > Xml Feed

7. In the Xml Feed row, click.
8. On the Configure Gateway window, check for XML code in the Configuration XML field. If the XML statements are not provided, copy and paste the following code into the field:

```xml
<Configuration>
  <DeviceType>FEED</DeviceType>
</Configuration>
```

9. Click Submit.
10. Click Save.
11. Click More Actions > Enable.
Set up mass device endpoints (targets)

To create a speaker pole, zone, or an all-poles user, an operator should perform the normal mass device endpoint creation flow. You should give the endpoint a functionally descriptive name so that it is recognizable in notification templates and Report windows as a mass-communication device target entity.

Create mass device zone and pole endpoints

1. Log in to BlackBerry AtHoc management system as an administrator.
2. In the navigation bar, click Mass Devices Endpoints.
3. In the Devices section, click Mass Device Endpoints.
5. Select ATI Giant Voice from the list. The New Mass Device Endpoint window opens.
6. To create a new endpoint for an All Poles zone, complete the following steps:
   a. In the General section, for the Display Name field, enter a name that describes the function of the associated call key, so that it is easy to identify which key is for which function.
   b. In the Configuration section, select Zone for Giant Voice type.
   c. In the Address field, enter “A,x”, where “x” is the RTU function number of the public address function (in this case RTU function 7[PA]). Ensure there are no commas or spaces in this “address” nomenclature.
7. To create a new endpoint for a preconfigured zone, complete the following:
   a. In the General section, for the Display Name field, enter a name that describes the function of the associated call key, so that it is easy to identify which key is for which function.
   b. In the Configuration section, select Zone for Giant Voice type.
   c. In the Address field, enter “Z,x,y”, where “x” is the number designator of the Zone being configured and “y” is the RTU Function number of the Public Address function (in this case, zone 1 and RTU Function 7[PA]). Ensure there are no commas or spaces in this “address” nomenclature.
8. To create a new endpoint for a pole, complete the following:
   
a. In the General section, in the Display Name field, enter a name that describes the function of the associated call key, so that it is easy to identify which key is for which function.
   
b. In the Configuration section, select Pole for Giant Voice type.
   
c. In the Address field, enter “P,x,y”, where “x” is the number designator of the Pole (or RTU) being configured and “y” is the RTU Function number of the Public Address function (in this case, pole 1 and RTU Function 7[PA]). Ensure there are no commas or spaces in this “address” nomenclature.

9. Click Save.

Create a mass device key endpoint

To create the object that displays the list of keys associated with an ATI Giant Voice system, complete the following tasks:

• Create the mass device key endpoint attribute XML configuration
• Create a key mass device endpoint

Configure the key XML attribute

To configure the Key XML attribute, refer to the ATI system functions key table in the Enable the ATI Giant Voice device section and follow the function list to create the following file:

Note: The key name and description parameters cannot contain spaces or any of the following characters: ' ! $ % ^ ( ) { } ; : ? " < > |
Note: In BlackBerry AtHoc release 7.9 or later release, when no endpoint is selected, and the targeting rule is MSG-TARGETING-REQUIRED, an alert template is not ready to publish.

<giantsVoiceSetting>
  <messages>
    <message id = "MSG-TARGETING-NOT-ALLOWED">The Giant Voice Key you have selected on the previous page does not allow additional selection of Giant Voice poles or zones. You may still target users for other devices, but Giant Voice targeting will be ignored.</message>
    <message id = "MSG-TARGETING-ALLOWED">The Giant Voice Key you have selected on the previous page already has Giant Voice poles and zones targeted, but you can override them by targeting different zones in the Targeting area just below.</message>
    <message id = "MSG-TARGETING-REQUIRED">The Giant Voice Key you have selected on the previous page does not have any targeting information built-in, and will require you to target at least one Giant Voice pole or zone below.</message>
  </messages>
  <keys>
    <key id = "1|NoPA|Emergency|NoStrobe|NoMopp"
         messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
         targetingRule = "TargetingNotAllowed">
      <name>Key Name</name>
      <description>Key description</description>
    </key>
    <key id = "1|NoPA|Emergency|NoStrobe|NoMopp"
         messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
         targetingRule = "TargetingNotAllowed">
      <name>Cancel</name>
      <description>Cancel</description>
    </key>
    <key id = "2|NoPA|Emergency|NoStrobe|NoHeatCondition"
         messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
         targetingRule = "TargetingNotAllowed">
      <name>Weekly Siren Test</name>
      <description>Weekly Siren Test</description>
    </key>
    <key id = "3|NoPA|Emergency|NoStrobe|NoHeatCondition"
         messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
         targetingRule = "TargetingNotAllowed">
      <name>Attack</name>
      <description>Attack</description>
    </key>
    <key id = "4|NoPA|Emergency|NoStrobe|NoHeatCondition"
         messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
         targetingRule = "TargetingNotAllowed">
      <name>National Anthem</name>
      <description>National Anthem</description>
    </key>
    <key id = "5|NoPA|Emergency|NoStrobe|NoHeatCondition"
         messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
         targetingRule = "TargetingNotAllowed">
      <name>Tornado</name>
      <description>Tornado</description>
    </key>
  </keys>
</giantsVoiceSetting>
<description>Tornado</description>
</key>

As "PA" is the default function of the IIM and used only in IIM, it is included in the Device XML and not in the Key XML. Hence, there is no need to create a new Key entry.

There are four entries in the Key XML for function 6, whereas all other functions have one entry each. Function 6 has four Sub-Commands or areas that serve as sub-functions. All four functions have different names and entries in the "ID" string of the XML so that the REACT4000 knows which one of the four functions to initiate for that key entry.

Create a key mass device endpoint

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. In the navigation bar, click ➧.
3. In the Devices section, click Mass Device Endpoints.
4. Click New and select ATI Giant Voice from the list.
5. In the General section, enter an endpoint name and a display name.
6. In the Configuration section, select Key for Giant Voice Type.
7. Copy the Mass Device Key XML configuration from the KEY XML into the Giant Voice Key field.
8. In the Address field, enter K.
9. Click Save.
Create and publish an ATI Giant Voice alert template

Prerequisites

- Before you start sending test alerts through ATI Giant Voice, consider the impact it has on everyone within hearing distance of the poles you are using during the test.
- This process assumes that the IIM is not configured to download data from the BlackBerry AtHoc management server and is not connected to the Giant Voice equipment.
- Consult with your POC as to the acceptable content of the test alert. For example, the word “test” should appear at, or very near to, the start of the broadcast message.
- Although the initial use of this template is to test the data creation process, this template can be used during the audio tuning phase after the IIM and Giant Voice hardware are connected.

To confirm that the ATI Giant Voice device is installed correctly on the BlackBerry AtHoc management system, create a template.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. Click Alerts > Alert Templates.
3. Click New.
4. On the New Template screen, in the Alert Template section, enter a template name and description.
5. Select a folder from the Folder list.
7. In the Content section, enter the title and content of the alert.
8. In the Mass Devices section, select ATI Giant Voice and then from the list select one or more Mass Alert Endpoints.
9. In the Mass Device section, click Options.
10. On the Mass Device Options screen, select Text to Speech and Alert Body or Custom Text.
11. Click Apply.
   Note: A valid key must be selected for the template to be ready to publish.
12. In the Schedule section, change the Alert Duration to 15 minutes.
13. Click Save.
14. Click to go to the Home page.
15. In the Quick Publish section, select the alert template you just created.
16. Click Review and Publish.
17. Review the settings and selections and click Publish.

Verify the published alert

To verify that the alert was published successfully to the syndication feed, complete the following steps:

1. Open a browser and navigate to the following URL: https://<url>/syndication/CAP_ATI<vps-id>/capindex.
   Where <url> is the base URL of the BlackBerry AtHoc management system (for example, https://integration7.athoc.com) and <vps-id> is the 7 or 8-digit Org ID.
2. Copy the content in the <url> field into another browser. The "capIndex" XML format must be similar to the content in the following image:
3. Copy the highlighted url into a new browser or a new tab and press **Enter**.

4. Verify the `<addresses>` and `<code>` match with the following format. The “alert” XML format must be similar to the content in the following image:

![XML Format Example](image)

5. If any of the formatting does not match, review the ATI Giant Voice Gateway XML content and Mass Communication ATI Giant Voice device addressing.
Test pre-installation legacy functionality

Before making any modifications to the ATI hardware programming or wiring, ensure that the legacy functions are operational. Any pre-existing problems that were not identified during testing before making changes to wiring or programming configuration could make troubleshooting more difficult after full system testing begins.

If the site has ATI MassAlert™ software, have the customer or site operations POC initiate a Quiet Test and Health Feedback function of the poles and observe the health statuses of each pole on the MassAlert™ software.

In addition, the site should initiate a Public Address function and make a manual microphone announcement. The microphone announcement should be observed as providing a loud and clear signal from an unobstructed listening position 100–200 yards from a Giant Voice pole, preferably in line-of-site with the pole and not near any buildings or large structures.

Record any displayed faults or lack of clarity of any broadcasts observed. It may only be possible to create audio with the new integration on par with the legacy audio functionality.
Configure IIM IP connectivity

This chapter describes the steps to configure the IP Integration Module (IIM) to communicate with the BlackBerry AtHoc ATI GV device.

Prerequisites

Ensure that the following packages are installed and configured before performing any tasks:

- Latest ATI GV BlackBerry AtHoc device package
- Latest ATI IIM Capnode package

To work as part of the BlackBerry AtHoc system, IIM must be able to communicate with the BlackBerry AtHoc server to download the CAP packets.

The initial configuration data you need to collect are:

- The BlackBerry AtHoc Alerts system base URL
- The BlackBerry AtHoc Alerts Organization ID
- Customer’s proxy server and port information (if applicable)

To find this information, use a local PC to log in to your local instance of the BlackBerry AtHoc management console. The URL can be a base “https” address used to access a specific system. You can obtain the URL of the system from the local system administrator or from the Blackberry Customer Support team. Launch the BlackBerry AtHoc management console. The URL from the “https” to the last character before the third forward slash (/) is the “base URL” of the system. For example, in the following URL, the full URL for the sign-on page is: https://integration7.athoc.com/client/auth/login?ReturnUrl=%2fclient%2fathoc-iws. The "base-URL" of the system is https://integration7.athoc.com.

The organization ID is a 7 or 8-digit numerical identifier of the specific system of that customer. To obtain this organization ID, log in to the BlackBerry AtHoc management system for the customer. Once logged in, you can find the system’s organization ID at the top right of the Home Page of the system.

Navigate to the settings page of the browser and determine if you are using any type of Proxy server for routing internet traffic. For example, if the browser you are using is Microsoft Internet Explorer (IE), go to the LAN settings, in IE, select Tools > Internet Options. On the Internet Options screen, click the Connections tab. At the bottom of the window, click LAN settings.

In the Proxy Server section, click Advanced. The Proxy Settings screen displays the Proxy Server Address. Record the proxy server address and the port number. You can now close these settings windows and exit IE.

Note: It is also possible that your IE instance may not use proxy servers. If this is the case, when you click LAN settings, no proxy server is used for internet traffic on this network. The proxy settings will be set to Automatically detect settings.

Configure the IIM and property files

At times, there can be several different configurations and operational property files on the IIM that you need to modify to correctly configure the unit to work within your integration environment. For example, the system_private.config and system.config files.

The most common file you can modify is the system_private.config file. This file is used to configure the operational environment parameters, as well as the TTS parameters of IIM.

To configure the system_private.config file, complete the following steps:

1. Open Microsoft Notepad as an administrator.
2. Click File > Open.
3. Navigate to C:\Program Files\capnode and change the file selection from "Text Documents (*.txt)" to "All Files (*.*)".
4. Select the **system_private.config** file.
5. Click Open.
6. Verify the following items in the **system_private.config** file:
   
   a. The `indexURL` variable should be formatted similar to the following image. The base URL should be followed by "/syndication/", then the device gateway protocol ID (for example, CAP_ATI for an ATI Giant Voice system), the Organization ID number, followed by "/capindex".
   
   b. The "#" at the beginning of a line in the **system_private.config** file is used to comment out or null out an unused line. The "#" should be removed from a line to use the variable.
7. Enter the proxy server and proxy port information you collected earlier in the proxyServer and proxyPort parameters. If the settings on the machine that you tested with is set for "Automatic" in the proxy settings, the settings for those two lines displays as follows:
   
   - proxyServer=none
   - proxyPort=8080
8. Update the `delayBetweenRxPolls` variable and ensure it is set to the default of "7". This variable determines the rate at which the IIM queries the BlackBerry AtHoc application server for any posted messages for the IIM to act on. This settings rate is set in seconds.
9. Update the **CapPostingTarget** variables to reflect the correct URL using the same base URL as in the `indexURL` variable. The **CapPostingTarget** variable is not exactly identical to the "indexURL" variable. This is by design, only change the base_URL of that **CapPostingTarget** variable.

10. The ATI COM Port settings displayed in the following images are default values and should not be changed.
11. Click File > Save. Close the **system_private.config** file.
12. Restart the CapCon services.
Restart the CapCon service

Once any changes have been made to any of the configuration files or property files, the CapCon service on the IIM must be restarted for the program to import those new settings and apply them to the system.

1. Navigate to your IIM system.
2. Select Start > Run > Services.
3. Launch an instance of the Services Manager application.
4. On the Service Manager screen, scroll down to the IIM CapCon Service section.
5. Right-click the CapCon Services row and select either Restart or Stop.
6. Right-click the CapCon Service again and click Start.

Verify the CapCon system activity console (GUI)

1. Log in to the IIM console as an administrator. The CapCon Console loads automatically.

   The data in the CapCon System Activity console displays the CapCon service activity as it polls the BlackBerry AtHoc application server at the rate set by the delayBetweenRXpolls variable in the system_private.config file. The default is set to 7 seconds. A message indicates the total number of active notifications in the BlackBerry AtHoc notifications index at that time.

2. Monitor the lower CapCon System Errors/Exceptions/Warnings Console window in the GUI. Verify that the IIM console does not show any new errors.

3. Verify that the console icon in the task tray appears green, indicating that the connectivity between the IIM and BlackBerry AtHoc is good.
Troubleshooting

If the CapCon System Activity console indicates anything other than a total number of items in the index and a number, or if the CapCon System Errors/Exceptions/Warnings console has content in red, this indicates that the configuration has not been executed correctly.

1. If the BlackBerry AtHoc management system, for example, https://integration7.athoc.com/athoc-iws is available on IE on a local workstation, then the indexURL should also be available. Enter the indexURL in the browser. For example, https://integration7.athoc.com/syndication/CAP_ATI/2086867/capindex.

2. If there are items in the feed, an XML similar to the following image should be displayed:

   ```xml
   - <?xml version="1.0"?>
   <capIndex xmlns="http://www.incident.com/cap_index/1.0">
     <title>Current CAP Messages</title>
     <updated>2018-03-26T08:51:11.2144241-07:00</updated>
     - <item xmlns="http://www.incident.com/cap_index/1.0">
       <id>31998A16-210C-4B07-92B8-4E6873C91BE4</id>
       <identifier>31998A16-210C-4B07-92B8-E6873C91BE4</identifier>
       <sender>AtHoc Admin</sender>
       <status>System</status>
       <msgType>Alert</msgType>
       <firstEffective>2018-03-26T11:51:03.067</firstEffective>
       <lastExpires>2018-03-26T11:55:03.067</lastExpires>
       <bounds />
       <format>http://www.incident.com/cap/1.1</format>
     </item>
   </capIndex>
   ``

3. If connectivity is still not good, try commenting out the `proxyServer` and `proxyPort` variables.

4. If an HTTP or HTTPS error is displayed instead of XML, this may indicate a firewall or certificate issue or a configuration problem with the BlackBerry AtHoc server syndication folder or subfolders.

5. Check the indexURL and proxy settings in the `system_private.config` file for any misspellings. If any line has been misspelled, repeat the configuration steps.

6. Check the `capnodelog` file for errors. Open Windows Explorer by right-clicking on the IIM Start button and navigate to `C:/Program Files/capnode/capnodelogs` and open the newest `capnode.log` file with Notepad. Browse the file to find the time that the indexURL was changed and the CapCon service restarted.

7. Contact BlackBerry AtHoc technical support. Be prepared to provide the `system_private.config` and `capnode.log` files and screen shots of the console screen and the BlackBerry AtHoc management console pages.
Test post-installation final legacy functionality

Once the wiring modifications needed to complete the integration are complete, the integrator must ensure that the legacy functions of the original system are still operational.

**Note:** For instructions about the wiring modifications, contact the BlackBerry AtHoc Customer Support team and request a copy of the *BlackBerry AtHoc IIM Central Control Unit Interconnection Guide*.

This is essentially the same test that was performed before the modifications were made. This test must be performed again to ensure that any changes that were made have not created any problems with the legacy system's operation.

If the site has REACT4000 or the MassAlert™ software, have the customer or site operations POC initiate a Silent Test and Health Feedback function of the RTUs and observe the health statuses of each RTU on the REACT4000 or the MassAlert™ software.

The site should initiate a Public Address function and make a manual microphone announcement. The microphone announcement should be observed as providing a loud and clear signal from an unobstructed listening position 100–200 yards from a Giant Voice pole, preferably in line-of-site with the pole, and not near any buildings or large structures.

Record any changes in operation since the pre-installation legacy functionality testing stage. If functionality does not work as expected, review the work that was performed and verify that all wiring has been terminated.
Publish and verify the pre test alert templates

Prerequisite

- Before you start sending test alerts through ATI Giant Voice, consider the impact on everyone within hearing distance of the poles you are using during the test.
- Consult with your POC as to the acceptable content, user targeting, and device selection of the pre-test notification.

Create and publish a pre test alert template

To create a template that targets end users using Desktop Popup, email, and messages to other devices to inform them of a Giant Voice System test, complete the following steps:

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. Click Alerts > Alert Templates.
4. In the Alert Template section, enter a template Name and Description.
5. Select a folder from the Folder list. Select Test if available.
6. Select the Available for quick publish check box.
7. Select Informational from the Severity list and Other from the Type list.
8. In the Content section, enter an Alert Title (can be the same as the template name) and enter the text to be read by the text-to-speech in the Alert Body field. The Body should contain the details of the testing with information such as the time testing will start and finish and any actions that should be taken as a result.
9. In the Target Users section, select the appropriate targeting group, individual users, or advanced query attributes to use when sending the pre-test notification.
10. Click Select Personal Devices and then select the Desktop App and Email-Personal check boxes.
11. Click Options in the top right corner of the Personal Devices section. The Personal Device Options screen opens.
12. Select the App Template and App Audio options from the list.
13. Click Apply.
14. In the Schedule section, change the Alert Duration to the expected duration of the testing.
15. Click Save.
16. Click the (Globe) icon to go to the Home page.
17. Find the Giant Voice System Test Notification template in the Quick Publish section and click the Review and Publish link.
18. Review the settings and selections and click Publish.
19. To verify that the alert was published correctly, observe the receipt of Desktop Popup or email messages on the POC workstation.

Verify the serial communication

If the system has been configured with a Key device containing Cancel All or Quiet Test commands, these keys can be used to test the serial interconnection without generating any sound through the Giant Voice System.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. On the Home page, in the Quick Publish section, search for Giant Voice System Test and then click Edit.
3. In the Mass Devices section, select ATI Giant Voice.
4. In the **Mass Devices** section, click **Options**.

5. On the **Mass Devices Options** screen, select **Giant Voice Key** and from the list select **Cancel** or **Silent Test**.

   **Note**: Keys use implicit targeting. For example, the targeting is built into the REACT4000 Activation Function or the ATI MassAlert™ software Hot Keys, and targeting is not allowed when using ATI Giant Voice Keys.

6. Click **Apply**.

7. In the **Schedule** section, change the **Alert Duration** to 15 minutes.

8. Click **Review and Publish**.

9. Review the settings and selections and click **Publish**.

10. Observe the operations of the following:

    - In the IIM console window: the number of items in the index increases and it starts processing the alert.
    - The REACT4000 or MassAlert™ software transmits the Activation Function or Hot Key selected in the BlackBerry AtHoc management system.
    - The associated Giant Voice poles emits no sound because of the command sent.

11. If unexpected results are found, do the following:

    a. Double-check the REACT4000 Activation Function programming or the MassAlert™ software Hot Key configuration.
    b. Verify that the BlackBerry AtHoc Mass Device Key Endpoint attribute configuration file is constructed correctly.

12. If activation fails, double-check the serial cable connections, IIM Com Port settings, and **system_private.config** file serial configuration variables.

### Adjust the .wav file audio level

IIM pre-recorded audio and text-to-speech audio tuning audio calibration must be performed in steps to calibrate the individual audio levels for pre-recorded audio (.wav file) play and text-to-speech. Some adjustments can be made by ear but can be more accurate if diagnostic tools are used. For radio-based systems, if a radio meter with an FM deviation scale can be used, the accuracy of the tuning can be more precise. For non-radio-based systems, a digital voltage meter can be used to read the levels of the transmitted audio.

Depending on the integration type, there can be different variables in the **system_private.config** file that need to be tuned. For ATI, the variables that typically require tuning are related to time delays, variables with “before” or “after”, and text-to-speech attributes variables with “TTS”.

1. Adjust the IIM Windows Audio Tool Tray Slider to approximately 25% as a starting point. The Giant Voice System Test template should be edited to use pre-recorded audio content, typically the Test GVS file. Observe the audio level and clarity in comparison with the manual activation baseline.

2. Log in to the BlackBerry AtHoc management system as an administrator.

3. In the **Quick Publish** section, select the **Giant Voice System Test** template and click **Edit**.

4. In the **Mass Devices** section, select **ATI Giant Voice**.

5. In the **Mass Devices** section, click **Options**.

6. On the **Mass Devices Options** screen, select **Pre-recorded Audio** and then select **Test GVS** from the list.

7. Click **Apply**.

8. Click **Review and Publish**.

9. Review the settings and selections and click **Publish**.

10. Observe the operations of the following:

    - In the IIM console window, the number of items in the index increases and that it starts processing the alert.
    - The REACT4000 or MassAlert™ software transmits the Public Address RTU Function.
    - The associated Giant Voice poles and the audio volume and clarity.

11. Adjust the IIM Windows Audio Tool Tray Slider to match the baseline audio level and clarity.
12. Repeat steps 2 to 11 until the pre-recorded audio sounds close in volume and clarity to manual microphone announcements.

**Adjust the Text-to-speech audio level and characteristics**

The previously configured Giant Voice System Test template should have been configured to use POC-approved verbiage and text-to-speech. Launch an alert using the TTS functionality of the BlackBerry AtHoc management system and observe the audio level and clarity of the TTS broadcast over the GV system’s speakers in comparison with the manual activation baseline and make adjustments as required.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. In the **Quick Publish** section, select **Giant Voice System Test** and click **Edit**.
3. Click **Review and Publish** to review the settings and selections.
4. Click **Publish**.
5. Observe the operations of the following:
   - In the IIM console window, the number of items in index increases and that it starts processing the alert.
   - The REACT4000 or ATI MassAlert™ software transmits the Public Address RTU Function.
   - The associated Giant Voice poles and the audio volume and clarity.
6. Using Microsoft Notepad, open the **system_private.config** file located at **C:\Program Files \capnode\system_private.config**.
7. In the Notepad file, find the following:
   - `encoder.SirenCentralEncoder.TTS_Volume` variable and adjust up or down to match the baseline audio level.
   - `encoder.SirenCentralEncoder.TTS_Speed` variable and adjust up or down to adjust the rate of speech. The speed variable is in words per minute.
   - `encoder.SirenCentralEncoder.TTS_Pitch` and `encoder.SirenCentralEncoder.TTS_Range` variables and adjust up or down to adjust the pitch and inflection of the speaking voice.
8. Click **File > Save**.
9. Using the Service Manager, restart the CapCon Services.
10. Run another test and observe the audio characteristics.
11. Repeat steps 2 to 10 until the prerecorded audio sounds close in volume and the clarity to the baseline.

**Adjust the function sequencing**

The previously configured Giant Voice System Test template should have been configured to use POC-approved verbiage and text-to-speech. Observe the timing of the IIM and MassAlert™ software. If the audio is being clipped at the beginning or end, or if there is a long delay before or after the audio, make adjustments to variables in the **system_private.config** file to adjust the sequencing.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. In the **Quick Publish** section, select **Giant Voice System Test** and then click **Edit**.
3. Click **Review and Publish** to review the settings and selections.
4. Click **Publish**.
5. Observe the operations of the following:
   - In the IIM console window, the number of items in index increases and that it starts processing the alert.
   - The REACT4000 or MassAlert™ software transmits the Public Address RTU Function.
   - The associated Giant Voice poles and the audio volume and clarity.

**Note:** The typical sequence of IIM operation when receiving alerts with text-to-speech content is for the poles to turn on the Public Address (PA) mode, transmit the TTS content and then turn off when a Cancel command is received. The siren poles also turn off after 7 to 10 seconds without receiving a command or
audio content on air. In many cases, the Cancel command can be delayed after the audio by approximately 13 seconds and the sirens turn off before receiving the Cancel command, with the command reserved for canceling in poor conditions. However, in systems with noisy RF conditions, the Cancel command should be sent immediately after the audio content so that squelch noise and other on-air transmissions stop the broadcast.

6. Using Microsoft Notepad, navigate to `C:\Program Files\capnode\system_private.config` and open the `system_private.config` file.

7. In the Notepad file, find the following:
   - `encoder.SirenCentralEncoder.ptt_before` variable and adjust the delay between the time the IIM sends the PA function activation command to the REACT4000 and the time that the REACT4000 actually starts sending the audio stream over the air to the speaker poles. In the ATI system, this time is typically 22 to 25 seconds (22000-25000). This delay is required by the ATI system as the ATI REACT4000 takes time to send the PA command to all endpoints in the system. The base value is in milliseconds.
   - `encoder.SirenCentralEncoder.ptt_after` variable and adjust the delay of time the IIM continues to hold the system PTT active after the IIM stops broadcasting audio stream. This variable is typically set to 2000. The base value is in milliseconds.

8. Click **File > Save**. Close the Notepad file.

9. Using the **Service Manager**, restart CapCon services.

10. Run another test and observe the audio characteristics.

11. Repeat steps 2 to 10 until the prerecorded audio sounds close in volume and the clarity to the baseline.
BlackBerry AtHoc Customer Support Portal

BlackBerry AtHoc customers can obtain more information about BlackBerry AtHoc products or get answers to questions about their BlackBerry AtHoc systems through the Customer Support Portal:

https://support.athoc.com

The BlackBerry AtHoc Customer Support Portal also provides support via computer-based training, operator checklists, best practice resources, reference manuals, and user guides.
Documentation feedback

The BlackBerry AtHoc documentation team strives to provide accurate, useful, and up-to-date technical documentation. If you have any feedback or comments about AtHoc documentation, email athocdocfeedback@blackberry.com. Please include the name and version number of the document in your email.


For more information about BlackBerry AtHoc products or if you need answers to questions about your BlackBerry AtHoc system, visit the Customer Support Portal at https://support.athoc.com.
Legal notice

©2020 BlackBerry Limited. Trademarks, including but not limited to BLACKBERRY, BBM, BES, EMBLEM Design, ATHOC, CYLANCE and SECUSMART are the trademarks or registered trademarks of BlackBerry Limited, its subsidiaries and/or affiliates, used under license, and the exclusive rights to such trademarks are expressly reserved. All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or made available on the BlackBerry website provided or made accessible "AS IS" and "AS AVAILABLE" and without condition, endorsement, guarantee, representation, or warranty of any kind by BlackBerry Limited and its affiliated companies ('BlackBerry') and BlackBerry assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or omissions in this documentation. In order to protect BlackBerry proprietary and confidential information and/or trade secrets, this documentation may describe some aspects of BlackBerry technology in generalized terms. BlackBerry reserves the right to periodically change information that is contained in this documentation; however, BlackBerry makes no commitment to provide any such changes, updates, enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or services including components and content such as content protected by copyright and/or third-party websites (collectively the “Third Party Products and Services”). BlackBerry does not control, and is not responsible for, any Third Party Products and Services including, without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services in this documentation does not imply endorsement by BlackBerry of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABILITY QUALITY, NONINFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL BLACKBERRY BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH BLACKBERRY PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF BLACKBERRY PRODUCTS OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES
WERE FORESEEN OR UNFORESEEN, AND EVEN IF BLACKBERRY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, BLACKBERRY SHALL HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREBIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREBIN; AND (B) TO BLACKBERRY AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED BLACKBERRY DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF BLACKBERRY OR ANY AFFILIATES OF BLACKBERRY HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your airtime service provider has agreed to support all of their features. Some airtime service providers might not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for availability, roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with BlackBerry’s products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party Products and Services and if any third party licenses are required to do so. If required you are responsible for acquiring them. You should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and Services that are provided with BlackBerry’s products and services are provided as a convenience to you and are provided “AS IS” with no express or implied conditions, endorsements, guarantees, representations, or warranties of any kind by BlackBerry and BlackBerry assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and Services shall be governed by and subject to you agreeing to the terms of separate licenses and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or other agreement with BlackBerry.

The terms of use of any BlackBerry product or service are set out in a separate license or other agreement with BlackBerry applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY BLACKBERRY FOR PORTIONS OF ANY BLACKBERRY PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

BlackBerry Enterprise Software incorporates certain third-party software. The license and copyright information associated with this software is available at http://worldwide.blackberry.com/legal/thirdpartysoftware.jsp.

BlackBerry Limited
2200 University Avenue East
Waterloo, Ontario
Canada N2K 0A7

BlackBerry UK Limited
Ground Floor, The Pearce Building, West Street,
Maidenhead, Berkshire SL6 1RL
United Kingdom

Published in Canada